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IDENTIFICATION OF BINDER AND FIBERS AND 

ANALYSIS OF FIBER PROPERTIES IN FIBROUS MEDIA 

INTRODUCTION 

The FiberFind module covers the functionalities in GeoDict that aim to understand 

3D scans of fibrous materials, like nonwovens and fiber-based composites, e. g. glass 
fiber reinforced or carbon fiber reinforced composites. FiberFind requires as input 3D 

models that are previously obtained from segmented micro CT scans or FIB/SEM 

scans of the material.  

Three distinct approaches are being followed in FiberFind:  

1. Estimate statistical properties of fibers: diameter distribution, orientation 

distribution, curviness, and curliness  

2. Identify individual fibers by classical image processing methods 

3. Identify individual fibers and binder by Artificial Intelligence (AI) approaches 

In FiberFind, we assume that pores have already been separated from solids, and 

that the solids consist of individual fibers and possibly some binder. Binder and fibers 

usually have the same gray values in the images. An automatic separation based on 
the gray value is therefore not possible. FiberFind with the submodule FiberFind-AI 

provides the possibility of separating binder from fibers automatically prior to the 

identification of separate fibers. 

FiberFind analyzes the diameter, orientation, and curvature of fibers, to estimate the 

performance of fibrous structures. 

FiberFind is the starting point to reproduce fibrous structures with FiberGeo. The 

user can input the statistical parameters obtained with FiberFind in FiberGeo and 

model isotropic and anisotropic materials. Subsequently, the statistical parameters 

of the modelled structure may be easily varied to investigate the effect of material 

structure on the performance of materials. By being used together, FiberFind and 

FiberGeo are intended to close the digital fibrous material design loop. 

FiberFind is particularly well suited for the analysis in fibrous structures made of non-

hollow fibers with circular cross-section. 

Since the AI approach for identifying binder and fibers was only introduced in GeoDict 

2019, currently some constraints for its application on the input data exist (see 
Current constraints on page 5), that will be removed in the further development of 

the AI capability. 

The AI approach of FiberFind is only available in the GeoDict GUI if a corresponding 

license is available. Otherwise, only the analytic modules of FiberFind can be used. 

Besides this handbook, several tutorials showing the possibilities of FiberFind-AI for 

different application cases are available on the GeoDict website.  

One tutorial is dealing with the analysis of four samples of different carbon paper 

gas diffusion layers used for a proton-exchange membrane in a fuel cell. Synchrotron 

scan data for the four samples is provided with the tutorial. The tutorial contains a 

https://www.geodict.com/Support/tutorials.php
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detailed description of the import and preprocessing of the data, the binder and fiber 

identification using the AI approach, and postprocessing options for the results.  

A second tutorial deals with the FiberFind identification of fibers of a composite 

material, a glass-fiber reinforced polymer, as well as the mechanical analysis of the 

digital 3D model with ElastoDict. Input data and detailed description about 

preprocessing of the data is provided with the tutorial. 
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SETTING UP FIBERFIND-AI AND BINDERFIND-AI FOR GPUS 

AND CPUS 

We describe here how to install FiberFind-AI and BinderFind-AI.  

In Testing that installation of BinderFind-AI works properly (below), we provide a 

short example (takes about 5 minutes to run) of how BinderFind-AI works and a 

short example on how the results of BinderFind-AI can be validated. 

FiberFind-AI uses the TensorFlow Framework by Google, one of the most used and 

well-known machine learning libraries. Since GeoDict 2021, the required version of 
TensorFlow will be installed during GeoDict installation and FiberFind-AI and 

BinderFind-AI will work out of the box. Install GeoDict with Administrator rights on 

your machine to install TensorFlow correctly. 

FiberFind-AI can run on the CPU (the main processor) or on the GPU (the graphics 

card). If a suitable GPU is detected during installation of GeoDict, FiberFind-AI and 

BinderFind-AI will run on the GPU, otherwise on the CPU. 

Since FiberFind-AI and BinderFind-AI ships with a limited number of neural networks, 

currently some constraints on the input data exist that are listed under Current 

constraints.  

USING THE GPU VERSION 

The GPU version is usually much faster (roughly factor 10) than the CPU version 

but it requires: 

◼ A good NVIDIA graphics card (GPU) installed, with compute capability of at 

least 3.5.  

Please make sure drivers are installed and up to date. For the version of CUDA that 

GeoDict 2022 is using, you need at least version 450.80.02 of the NVidia driver for 

Linux or version 452.39 for Windows. 

See more information on graphics cards in https://developer.nvidia.com/cuda-

gpus. This webpage contains a helpful section with Frequently Asked Questions. 

Remark: The manual installation of CUDA and TensorFlow is not necessary anymore 

since GeoDict 2021. 

 

These instructions are specific for GeoDict 2021 and 2022 and not 

intended for earlier GeoDict releases. To install the GPU version for 

GeoDict 2020 or GeoDict 2019, see the FiberFind handbook of the 

2020 User Guide. 

https://developer.nvidia.com/cuda-gpus
https://developer.nvidia.com/cuda-gpus
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
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THEORY – APPROACHES FOR FIBER IDENTIFICATION 

The following section explains the algorithms used by FiberFind. First, we explain the 
identification of binder and separate fibers with the AI approach, and the 

identification of separate fibers using the classical image processing approach. 

Then follows a short explanation of the estimation of statistical fiber properties, 

diameter distribution, orientation distribution, curviness, and curliness.  

AI APPROACH TO IDENTIFY BINDER AND FIBERS 

The FiberFind module provides the possibility of using Artificial Intelligence (AI) 
approaches for the separation of binder and fibers as well as the identification of 

individual fibers in a fibrous structure. 

In the image taken from a material, fibers and binder often have the same gray 

values, and therefore cannot be separated based on this value. The same holds true 

for the separation of different fibers. However, it is possible to separate binder from 

fibers and fibers from each other based on the shape in the image.  

 

The fundamental idea of AI is that a neural network is trained to perform a special 

task, here the identification of separate fibers or the differentiation between fibers 

and binder. To train the neural network, enough examples need to be available to 

teach it. Clearly, for 3D-scans it is a very hard and time-consuming task to manually 
label materials or objects for the number of examples required, which are typically 

hundreds of millions. This is where GeoDict’s unique structure-generation 

capabilities come in. 

The FiberGeo module can create innumerable models of fibrous media and can also 

add binder to these models. Variations of fiber diameters, fiber shape, fiber length, 

fiber curvature, fiber density, etc. and also the amount and location of binder can be 

carried out as needed. 

As long as the models are close enough to the real 3D-scans, GeoDict is 

capable of providing the needed ground truth data for the neural networks that 

embody the AI capability in FiberFind. Since GeoDict 2021, the capability to create 

and parameterize these neural networks is available in the module GeoDict-AI. For 

more details see the GeoDict-AI handbook of this User Guide. 

Based on the trained neural network, FiberFind identifies for each voxel of the 

structure whether it is binder or fiber and sets the material ID accordingly. 

https://www.geodict.com/Support/UserGuide.php?lang=en
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In the same way, a trained neural network identifies for a fiber structure for each 

voxel to which fiber it belongs. 

 

The current version of FiberFind-AI consists of two neural networks and BinderFind-

AI consists of a single neural network that can be applied to segmented data sets in 

the FiberFind module. Therefore, currently some constraints on the input data exist, 

that may make it necessary to preprocess the input data, before applying the AI 

approach. 

CURRENT CONSTRAINTS OF BINDERFIND-AI AND FIBERFIND-AI 

◼ Fiber diameters should be 4 to 10 voxels for binder identification and for fiber 

identification of short fibers. For the neural network for identification of long 

fibers, fiber diameters should be 6 to 14 voxels, ideally 8 or 9 voxels.  

If fiber diameters differ from this value, ImportGeo-Vol can be used to resample 

the voxel length. During the import of an image, the 3D Image Processing 

functionality Image Size→Scale can be used for scaling the 3D image with a 

different voxel length. Details can be found in the ImportGeo-Vol handbook of 
this User Guide, in the section 3D Image Processing in ImportGeo-Vol → 

Image Processing Tools → Image Size → Scale. 

◼ If fiber diameters in the structure are very different, and therefore, after 
resampling, not all diameters lie in the range listed above, we suggest separating 

the fibers and applying FiberFind-AI for each kind of fiber. 

To separate the fibers, Estimate Fiber Diameters in FiberFind can be used. 

Run the fiber diameter estimation and choose the number of fiber types in the 

Result Plots to fit to your structure. On the tab Result Visualization, you can then 
load a .gdt file with the fibers separated according to different fiber types. See 

Estimate Fiber Diameters below for detailed instructions and an example.  

◼ Some networks require fibers to be oriented mainly in the x-y plane. Please see 

the individual network description in the dialog. If necessary, the structure can 

be rotated to fulfill this condition. 

Changing the coordinate axis is done easily through ProcessGeo → Permute 

functionality. Details can be found in the ProcessGeo handbook. 

Changing the coordinate axis or applying complex rotations to the structure by 

defining Euler angles is also possible through ImportGeo-Vol. Details are 

explained in the ImportGeo-Vol handbook in 3D Image Processing in 
ImportGeo-Vol → Image Processing Tools → Image Alignment → 

Rotation. 

◼ Fiber identification works for circular fibers right now, not for other cross sections 

such as hollow or trilobal fibers. 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en


Identification of binder and fibers, and analysis of fiber properties 

6  GeoDict 2022 User Guide 

IMAGE PROCESSING APPROACH TO IDENTIFY SEPARATE FIBERS 

For the identification of separate fibers using the image processing approach, 

FiberFind identifies fibers using the known fiber center lines from voxel data of the 

structure model. A skeleton is created from the fiber center lines of the structure, 

that preserves the topology.  

The identification of fibers with classical image processing methods is optimized for 

low density fibrous materials. 

ANALYSIS OF FIBER DIAMETER, ORIENTATION, CURVATURE, AND 

CURLINESS 

The computation of the fiber diameter, fiber orientation, fiber curvature, and fiber 

curliness are explained directly below.  

If analytic object data is already loaded in the GeoDict GUI, the properties are 

computed directly based on these objects. Otherwise, if only a voxel image is 

available, the fibers are identified first, using an image processing approach, before 

running the analysis. 

COMPUTATION OF FIBER DIAMETERS 

The algorithm to estimate fiber diameters works as follows: At the start, each fiber 

voxel gets assigned the value of the largest sphere fitting into the fiber in this 

position. Then, it is checked for each fiber voxel if it lays inside of a larger sphere 

compared to the diameter of the sphere already assigned to the voxel under 

consideration. 

For this comparison, there are two possibilities: 

◼ The center of the smaller sphere lays in the larger sphere. Then, the diameter 

value of the larger sphere is assigned to all voxels in the smaller sphere. Voxels 

at the end of a fiber get like this the same diameter than neighboring parts of the 

fibers and not a smaller one. See the following figure. 

 

◼ The center of the smaller sphere does not lay in the larger sphere. Then, the 

overlapping area between both spheres is partitioned between both diameters. 

Like this, fibers overlapping each other both get the correct diameter. See the 

following figure. 
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COMPUTATION OF FIBER ORIENTATIONS 

To compute fiber orientations, two algorithms are used:  

◼ Star Length Distribution (SLD):  

1. Analysis is done on a per-voxel basis. 

2. For each voxel, it analyzes chord lengths through the voxel for a pre-defined 

set of directions. 

◼ Principal Component Analysis (PCA): 

1. The domain is cut into blocks of a fixed size (currently 32x32x32).  

2. For each block, all connected components are found. Ideally, they correspond 

to segments of individual fibers.  

3. For each component, it is assumed that the voxels of the component form a 

point cloud. An ellipsoid which best approximates this point cloud is computed 

using the PCA method (Principal Component Analysis) and provides the 

principal orientation.  

4. The principal orientation vectors are averaged to get a per-block orientation.  

5. Per-block orientations are averaged to obtain the desired number of 

orientation tensors.  

In summary, the PCA method cuts the fibers into segments and determines the 

local average of the orientation of these segments to obtain an orientation tensor.  

For both algorithms, GOF files (GeoDict Orientation Files) can be saved to analyze 

anisotropic properties (e.g. transverse isotropic) of fibrous structures. In case of 

transverse isotropy, the material properties in fiber direction differ from properties 

in the perpendicular direction.  

These GOF files can be used e.g. in ElastoDict for computations of mechanical 

properties in anisotropic materials. 
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COMPUTATION OF CURVATURE AND CURLINESS 

FiberFind can calculate curliness and curvature distributions in models of fibrous 

structures. Curved fibers occur in materials for numerous industrial sectors: 

synthetic filter media, cellulose filter media, gas diffusion layers (GDL) in fuel cells, 

insulation materials, nonwovens for many applications, etc. 

The calculated curvature is based on the definition of geometric curvature. At any 

point on the curve, the curvature is defined as the inverse radius of the osculating 

circle. The osculating circle has the same tangent vector as the curve at that point 

and approximates the curve locally.  

 

 

 

 

 

 

 

 

 

 

The curliness factor measured by FiberFind is the length of the fiber divided by the 

distance between its start and its end. For straight fibers, this results in a curliness 

factor of 1.  

 

 

 

 

 

 

 

 

 

FiberFind extracts the centerlines of fibers via skeletonization and calculates the 
curvature and curliness based on the centerline and the length of fibers. If no analytic 

data (.gad) is available, e.g., from a previously run fiber identification, FiberFind 

identifies the fibers with the classical image processing approach first. 

The curvature estimation component is intended to be used with highly porous 

fibrous media (>90%). Solid volume fractions above 10% can decrease the accuracy 

of the result. 
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MEMORY REQUIREMENTS FOR THE ALGORITHMS 

To get an estimation of the memory required by the FiberFind algorithms, the 

following table shows the memory per voxel that each of the algorithms needs for 

the computation. For this estimation, the number of voxels of the whole domain, not 

only the voxels occupied by fibers is relevant. 

 

Algorithm Required Memory per voxel 

Estimate Fiber Diameters 5 Byte 

Estimate Fiber Orientations 24 Byte 

Estimate Curvature 29 Byte 

Identify Fibers (AI) 5 Byte 

 

In each case, some overhead for the structure loaded and other information for the 

algorithm is necessary. However, especially for large structures, where the memory 

requirements are crucial, the values in the table are helpful to decide whether the 

memory available is enough for a computation on the loaded structure or not. 
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FIBERFIND SECTION 

FiberFind starts when selecting Analyze → FiberFind in the menu bar. 

Five processes are listed and can be selected from the pull-down menu in the 

FiberFind section: Estimate Fiber Diameters, Estimate Fiber Orientations, 

Estimate Fiber Curvature, Identify Fibers (AI) and Identify Binder (AI). 

 

The options for each process can be edited after selecting it from the pull-down menu 

and clicking the Options’ Edit… button.  

When the options for the selected FiberFind process have been entered, clicking Run 

starts the computation.  

When recording a macro, e.g. to run parameter studies, the Record button becomes 

active and the Run button changes to Run & Record. 

The results from all FiberFind computations are saved as *.gdr files in the project 

folder.  

GeoDict result files (.gdr files) can be opened with the GeoDict Result Viewer at any 

time by selecting File → Open Results (*.gdr) from the Menu bar. 
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For the analysis with FiberFind, a segmented image of the material needs to be 

available. ImportGeo–Vol can be used to import data of (µ)CT (or FIB/SEM) scans, 

to get a segmented three-dimensional model (see the ImportGeo-Vol handbook). 

ESTIMATE FIBER DIAMETERS 

Start with a 3D-model of a fibrous material that 

has been loaded in memory and is displayed in the 

Visualization area.  

 

 

 

 

 

 

 

In the FiberFind section, select Estimate Fiber Diameters from the pull-down 

menu and click the Options’ Edit... button.  

In the opening Fiber Diameter Estimation dialog, enter the desired Result File 

Name (.gdr) or keep the default FiberDiameters.gdr. 

From the Material to Analyze pull-down menu, select to analyze All Solid 

Materials in the 3D-model (analyze all solid and porous materials), only a Chosen 

Material, or materials of the Chosen Material IDs. 

 

 

 

 

 

When Chosen Material is 

selected, it is possible to analyze 
any material included in the 

model. 

https://www.geodict.com/Support/UserGuide.php?lang=en
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When Chosen Material IDs is selected, the user can choose to analyze any of the 

16 Material IDs that could appear in a model. This can be used when a material 

appears through overlapping of fibers, or to exclude binder from the fiber diameter 

analysis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Check Remove Fiber Fragments at Domain Boundary to remove fragments of 

fibers that touch the domain boundary after running the fiber identification 
algorithm. For fibers not contained in the computation domain completely, it may be 

not possible to estimate the correct diameter and length at the domain boundary. 

If the material is periodic in one or several directions, this can be accounted for by 

checking the boxes for Periodicity. For example, for periodicity in x-direction, fibers 

leaving the domain on one end in x-direction will be considered to relate to a fiber 

starting at the other end of the domain with similar y and z values. 

If any information is available about the minimal fiber diameter, this information can 

be entered in Minimal Fiber Diameter. This speeds-up the computation, as the 

algorithm starts with this minimal diameter and not with zero for the diameter 

estimation. However, since fiber segments with diameter smaller than the value 
given are ignored if they are not connected to a larger fiber, the recommendation is 

to enter a fiber diameter slightly smaller than the one known, to make sure that all 

fiber segments are considered. The minimal diameter can be defined in meter or as 

number of voxels. 

The Bin Size (in Voxel) defines the resolution of the diameter analysis for the result 
visualization as histogram and for the computation of diameter distribution for one 

or several types of fibers. It can be changed during postprocessing in the GeoDict 

Result Viewer. 

A result file with the entered Result File Name is saved in the chosen project folder 

(File → Choose Project Folder...) after the analysis, and a Result Viewer opens, 

showing the calculated values. The header section can be collapsed and expanded. 
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In the Result Viewer, the results are organized into Input Map, Log Map, Post 

Map, Results, Data Visualization and Metadata, which are accessed through the 

corresponding tabs.  

Under the Results - Report subtab, the average diameter and the corresponding 

standard deviation for all fibers, as well as averages and standard deviations of the 

binned histogram values for each fiber type are displayed. An example of two 

different fiber types is shown here. 

Below, a table lists the minimum and maximum diameter of each bin, as well as the 

volume fraction of fibers with this diameter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the post-processing section, left of the Results tab, the Bin Size (in Voxels), the 

Thresholding Method, and the Number of Fiber Types can be changed. These 

post-processing commands allow control on the display of the result data. The post-

processing section can also be collapsed and expanded. 

Changing the Bin Size changes the width of the histogram bin and, therefore, its 

resolution. 

Collapse and expand 

Collapse and expand 
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The Thresholding Method for the separation between fibers of different fiber types 

allows to choose between the K-Means, Otsu’s method and a Manual selection of 

the threshold. This option is only relevant for two or more different fiber types. 

If the analyzed structure contains fibers of different types, specify the Number of 

Fiber Types, and for each type, a Gaussian is fitted to the data. 

Click Apply to apply the changes to the histogram values shown, as well as to the 
plots shown on the Plots subtab and to the fiber type structure, that can be loaded 

on the tab Data Visualization.  

Under the Results - Plots subtab, the histogram computed shows for each fiber 

diameter the volume fraction of the fibers with this diameter, together with a 

Gaussian fit to the histogram data. In the example shown below, for one fiber type, 

the highest volume fractions correspond to fibers with diameters around 12 µm.  

However, in the example shown here, the structure consists of two fiber types: fibers 

with small diameter between 2-8 µm, and fibers with diameter between 9-18 µm.  

Choosing two different fiber types, leads to Gaussian distributions that fit much 

better to the fiber diameters present in the structure. The structure with a separation 

of the two different types of fibers is shown on page 15. 
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Under the Data Visualization tab, the Fiber Type Structure and the Fiber 

Diameter Distribution can be loaded. 

 

 

 

 

 

 

 

 

 

 

Clicking Load *.gdt opens a GeoDict structure. All fibers assigned to one fiber type 

have the same Material ID in this structure. In case of two different fiber types, as 

shown in the example here, fibers with small diameter have the Material ID 01 (here 

in yellow). Fibers with large diameter have Material ID 02 (here shown in grey) and 
are assigned to Fiber Type 2. The corresponding histogram of fiber diameters is 

shown on page 14.  

 

If postprocessing parameters in the 

Results tab (Bin Size, Thresholding 

Method, or Number of Fiber Types) are 
changed, the information in the .gdr file 

also changes. 

 

This information can be used for the 

separation of fibers with different fiber 
diameters. Reassign e.g. all voxels with 

Material ID 01 to ID 00 with ProcessGeo. 

In this way, only solid voxels with 

Material ID 02 remain in the structure 

and can be analyzed separately. 

 

Now, click the Load GeoDict Size 

Distribution (*.gsd) button to 

observe the computed fiber diameter 

distribution. Check Diameter as the 

volume field to be loaded and click OK.  
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Then, deselect the visualization of the structure, by clicking Yes in the dialog that 

pops up (or by choosing View in the Menu bar and uncheck the Structure box). 

 

 

 

 

 

In the Volume Field tab of the Visualization panel (above the Visualization area), 

with the Visibility set to material IDs 01 and 02, only the fibers are shown and not 

the pore space.  

 

 

 

 

 

 

 

 

 

 

 

The buttons for data management available at the bottom of the Result Viewer are 

explained in detail in the Result Viewer handbook of this User Guide. 

 

 

 

 

 

 

The units of length are meters (m) because, internal to GeoDict, all units are SI 
(Système International d’Unités) for which meter is the base unit for length. 

https://www.geodict.com/Support/UserGuide.php?lang=en
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ESTIMATE FIBER ORIENTATIONS 

Start with a 3D-model of a fibrous material that has been loaded in memory and is 

displayed in the Visualization area. In the FiberFind section, select Estimate Fiber 

Orientations from the pull-down menu and click the Options’ Edit... button.  

In the opening Fiber Diameter Estimation dialog, enter the desired Result File 

Name (.gdr), and select the Material to analyze as explained on page 11. 

 

For homogeneous materials, without variations in orientation, the domain can be 

analyzed as a whole and, therefore, the Number of orientation tensors in X 

direction, in Y direction, and in Z direction can be set to 1, 1, and 1.  

 

 

 

 

 

 

 

 

 

 

 

NZ=1 

NX=1 

NY=1 
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For non-homogenous fibrous materials, where fiber layers with varying orientations 

are present, the domain must be subdivided into blocks and an orientation tensor 

can be estimated for each block. The partition allows to analyze fiber orientation in 

these diverse areas of the domain, instead of having to cut the structure in parts 

and to analyze them separately.  

The size of the blocks is defined by setting the Number of orientation tensors, 

for which values can be set, e.g. to 3, 3, and 2, producing 18 blocks. 

 

 

 

 

 

These 18 blocks are labeled later in the result file as Block 0,0,0, Block 1,0,0, Block 

2,0,0, Block 0,1,0, Block 1,1,0, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

Next, choose a method for the analysis of fiber orientation: Star Length 
Distribution (SLD) or Principal Component Analysis (PCA, Automatic or Manual 

window size). 

 

 

 

 

 

The Star Length Distribution (SLD) method works on a per-voxel basis. For each 

voxel, it analyzes chord lengths through the voxel for a pre-defined set of directions.  

The relative length of the chords gives the per-voxel orientation tensor. Then, the 

tensors are averaged over all voxels included in a block. 

 

 

Block 0,0,0 

NY=3 

NZ=2 

NX=3 

Block 2,0,1 Block 0,2,1 
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The PCA method is an alternative approach that subdivides the domain into windows 
of a given size. The size of the window can be automatically determined based on 

maximum fiber diameter (Automatic window size) or manually entered in voxels 

(Manual window size). 

 

 

 

 

 

 

The subdivision into windows is applied to eliminate the influence of fiber crossings. 

Our PCA-based algorithm identifies fiber fragments and analyzes the direction tensor 
within each window. Then, it averages the direction tensors over all windows within 

a block to obtain the orientation tensor for that block.  

 

When needed, check Write GOF file to save a GeoDict Orientation File (GOF) with 

the per-voxel fiber orientation information. 

 

Domain Window Block 
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After the calculations, a Result Viewer opens showing the calculated fiber orientation 

tensors and solid volume fraction for each block. The tensor describes the statistical 

distribution of orientation in that particular block. 

With an undivided domain (1x1x1 blocks), only one tensor for the complete domain 

appears in the Result Viewer.  

 

 

 

 

 

 

 

 

 

 

 

 

With the domain subdivided into 3x3x2 blocks, the number of tensors is 18. 
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Independent on the number of blocks selected, the per slice components of the 

orientation tensor in X, Y and Z direction are shown for all three coordinate directions 

in the Results - Plots subtab.  

These components are shown here in a single Result Viewer: on the left for the 

undivided domain and on the right for the second domain subdivided into 3x3x2 

blocks. 

 

The fiber orientation in the blocks can be visualized by clicking Load .stl to get the 

3D Orientation Arrows under the Fiber Orientation Visualization tab. 
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The fibers of the structure obscure the orientation arrows. Go to the menu bar and 
turn off the visualization of the fibers by un-checking View → Structure. Orientation 

arrows are visible only in 3D view. Switch to it by selecting View → 3D Rendering. 

The direction of an arrow in a particular block shows the main fiber orientation in 
the block, and its length shows the strength of this main fiber orientation. The color 

of the arrows indicates the fiber solid volume fraction (SVF) in a block. The color 

range is green-yellow-orange-red. Assignment of color in a block depends on its SVF 

relative to the SVF of the other blocks. The block with the highest SVF gets a green 

arrow. The block with the lowest SVF gets a red arrow. When there is only one block 

(homogeneous material), the arrow is red. 

For a homogeneous material structure (no subdivision), only one arrow appears in 

the center of the single block. Here, the short arrow pointing in the X-direction 

indicates that although the fibers’ main orientation is on the X-axis, there is a great 

deal of dispersion. Values on the main diagonal in the orientation tensor in x- and y-

direction have nearly the same size (0.43 in x and 0.42 in y-direction), but the arrow 

shown points always in the direction of the larger one. 

 

 

 

 

 

 

 

 

 

For a heterogeneous material structure, divided into 3x3x2 blocks, 18 arrows appear 

that occupy the centers of each of the 18 blocks. All arrows are oriented closely to 

the Y-axis. The range of colors indicates that the SVF of some blocks (green arrows) 

is higher than that of others (red arrows). 
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Besides the 3D Orientation Arrows it is possible to visualize the GOF file (if one was 

calculated). Click Load *.gof under the Fiber Orientation Visualization tab of the 

Result Viewer. 

 

 

 

 

 

 

 

 

 

Select, e.g., to load the 

Orientation:AngleToX to get for 

each fiber segment the angle to 

the x axis.  

 

 

 

 

 

 

 

 

 

 

 

In the Visualization panel, above the Visualization area, uncheck the check box in 

the Structure tab. In the Volume Field tab, deselect Visibility for the pore space 

(Material 00). 
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ESTIMATING FIBER ORIENTATION IN LAYERED MATERIALS 

For a layered heterogeneous material, FiberFind can be used to estimate the fiber 

orientation in the layers by subdividing the domain according to the layers. For 

example, the domain of a material with three layers would be subdivided as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

When the calculations with FiberFind are finished, a Result Viewer for the fiber 

orientation result file opens showing the calculated fiber orientation tensors and solid 

volume fraction for each of the three blocks. The highest fiber solid volume fractions 

are in the top (Block 0,0,2) and bottom (Block 0,0,0) layers as can be seen in the 

Results - Report subtab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Block 0,0,2 

Block 0,0,1 

Block 0,0,0 

NZ=3 

NX=1 

NY=1 



FiberFind section – Estimate fiber orientations 

GeoDict 2022 User Guide  25 

 

 

 

 

 

 

 

 

 

 

The main orientation of the top layer (Block 0,0,2) is in Y-direction, the main 
orientation of the middle layer (Block 0,0,1) is in X-direction and the main orientation 

of the bottom (Block 0,0,0) layer is in the X-Y-direction. 

 

 

 

 

 

 

 

 

 

 

 

Whereas a great majority of fibers in the top layer are oriented in the Y-direction, 

the orientation in the middle layer and, particularly in the bottom layer, is more 

scattered. 
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REPRODUCING FIBROUS MEDIA USING FIBERFIND AND FIBERGEO 

The values of the orientation tensors and the calculated diameters can be entered in 

FiberGeo to generate a matching digital material model.  

Start with the values estimated by FiberFind for the fibrous material: the average 

fiber diameter and the diameter distribution for the whole domain, as well as the 

fiber orientation tensors for each block. This diameter distribution and the per-block 

orientation tensors can now be entered in FiberGeo to reproduce the fibrous material. 

Select Model → FiberGeo in the menu bar and click the Options’ Edit… button in 

the FiberGeo section. 

 

 

 

 

 

 

 

 

In FiberGeo, go to the Fiber Options tab and begin entering as many fibers of type 

Short Circular or Infinite Circular as the number of blocks in which the domain has 
been subdivided. For a homogeneous material, this is a single fiber type. For a 

layered heterogeneous material, this is a fiber type per media layer. In FiberGeo, it 

is possible to use up to 4 different fiber types. 

Later, all fibers can be assigned to the same Material ID. 

Set the Percentages are as Volume % (bottom right). 
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HOMOGENEOUS FIBROUS MEDIA 

For a homogeneous material (no layers), for the single 

fiber type, use the data from a fiber diameter result file 

(*.gdr) obtained with FiberFind and, for Diameter, 

enter the value of the estimated Average inner 

diameter.  

Alternatively, click the Diameter’s Edit… button and 

choose Gaussian (or Log-Normal) to enter the values 

of the Average inner diameter and the Standard 

deviation from the fiber diameter result file.  

It is also possible to choose Probability Distribution 
and to enter a stepwise distribution, e.g. from the 

histogram values of the fiber diameter estimation. 

 

Enter a Length that fits to the length of fibers in the structure (e.g. the length 

estimated during fiber identification (see Identify Fibers).  
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For the example shown above, with fibers going through the domain, enter a Length 

that is larger than the largest side of the domain. For a domain of 200 x 200 x 200 

used here, enter e.g. a length of 250 µm. Infinite circular fibers could be chosen as 

fiber type as well here. They already extend beyond the domain. 

 

Using a fiber orientation file (*.gdr) obtained with FiberFind, click now the 

Orientation Edit… button to enter these computed values. 
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Now, under the Create Options tab of FiberGeo, enter the estimated Solid Volume 

Fraction as Object Solid Volume Percentage in the Stopping Criterion panel. 

There are no layers and, thus, the calculated SVF corresponds to the Object Solid 

Volume Percentage of the complete media.  

 

 

 

1 
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Remember to set the correct domain size (NX, NY, NZ) and Voxel Length in the 

Domain panel (Create Options tab). 

Click OK to close the FiberGeo Create Options dialog and click Generate in the 

FiberGeo section.  

The reproduced fibrous material model appears in the Visualization area, matching 

the values estimated by FiberFind for the 3D material model obtained from importing 

(µ)CT images. 

 

 

 

 

 

 

 

 

 

 

HETEROGENEOUS (LAYERED) FIBROUS MEDIA 

For a heterogeneous material (layered), add as many fiber types as layers are in the 

media, corresponding to the blocks estimated by computations with FiberFind (for 

example, on a 3D material structure model obtained from importing a (µ)CT image. 

 

 

 

 

 

To enter the fiber type and the fiber diameter for 

each of them, use the data from the fiber diameter 

estimation result file (*.gdr) obtained with 

FiberFind and enter the estimated Average inner 

diameter directly. 

 

Alternatively, click the Diameter Edit… button for each fiber type, choose Gaussian 

(or Log-Normal), and enter the value of the estimated Average inner diameter 

and the value of Standard deviation for all fiber types (as shown above on page 

27).  

 

Notice that the fiber diameters of the different layers look fairly similar in the 

example shown. Because of this, only one fiber type (short circular) and the same 

values for the Gaussian distribution are selected. If the diameters should be different 
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in each layer, it is possible to choose three different fiber types and a different 

diameter distribution for each layer under the Fiber Options tab in FiberGeo. 
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In the example shown, most fibers do not end inside the domain. For short circular 

fibers, enter therefore a Length that is larger than the largest side of the domain. 

For example, being the domain 200x200x200, enter a length of 250 µm. 

The fiber type Infinite Circular cannot be used here, since we want to model a 

structure with three different layers and therefore also need to define the center of 

the fibers for each layer, see below. 

From the fiber orientations file (*.gdr), enter the values from the orientation tensors 

calculated for each block (layer) by clicking the Orientation’s Edit… buttons in the 

right panels. 

Block 0,0,1 Block 0,0,2 

Block 0,0,0 
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Next, for each layer, click the Center’ Edit… button and place the three types of 

fibers in layers by setting their centers uniformly in a box.  

The box for each layer should be constructed laterally bigger than the domain 

(200x200x200 µm). When the box is constrained to the domain, only fibers whose 

centers are inside of the domain are created. For a larger box, also fibers with a 

smaller part inside the domain are possible (see also the illustration below). 

 

 

 

 

 

 

 

 

 

 

Block 0,0,1 

Block 0,0,2 

Block 0,0,0 
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Finally, it is necessary to consider the contribution of every layer (fiber type) to the 

domain’s solid volume fraction (object solid volume percentage).  

Under the Fiber Options tab, the percentages had been selected to be viewed as 

Volume% (bottom right, see page 26). Enter the estimated solid volume fractions 

of the three blocks (18.747%, 8.294%, 17.7374%).  

After clicking OK in the dialog, FiberGeo adjusts the percentages automatically to 
sum up to 100%. For example, for Block 0,0,0 with SVP of 18.747%, the contribution 

is 41.8662% after percentages are automatically updated. 

Enter the Solid Volume Percentage of fibers in the structure as the Object Solid 

Volume Fraction in the Stopping Criterion panel, under the Create Options tab. The 

value is available under the Statistics tab in the 

Visualization Area. 

Remember to set the correct domain size (NX, NY, 
NZ) and Voxel Length in the Domain panel.  

Click OK to close the FiberGeo Create Options 

dialog and click Generate in the FiberGeo 
section.  

The reproduced fibrous material model is shown in 

the Visualization area, matching the values 

estimated by FiberFind for the 3D material model 
obtained from importing (µ)CT images. 



Reproducing fibrous media using FiberFind and FiberGeo 

GeoDict 2022 User Guide  35 

REPRODUCING CURVATURE OF FIBROUS MEDIA 

Like the fiber diameter and fiber orientation, it is also possible to create a model of 

a fiber structure with FiberGeo, using the curvature computed in FiberFind (see page 
36).  

For a curved fiber type, like Curved Circular, the Curl Mode Curvature can be 

chosen, and the Curvature Radius as well as other parameters can be defined. The 

Curvature Radius is the inverse of the curvature computed in FiberFind. For more 

details on using this feature, see the FiberGeo handbook of this User Guide in the 
section Curl Parameters. 

 

 

 

https://www.geodict.com/Support/UserGuide.php?lang=en
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ESTIMATE FIBER CURVATURE 

An analytic representation of the fibers (.gad file in GeoDict or .gdt file containing 

analytic data) is used for the estimation of curvature and curliness in FiberFind.  

If such analytic data is available and loaded into the GeoDict GUI, the algorithm 

works directly on this representation, which can be created e.g. by running a fiber 

identification with FiberFind (see Identify Fibers).  

If the computation is started on a voxel image, the analytic fiber identification 

algorithm (i.e., the one available for the Identification Method Analytic, see page 

40) is applied to the structure before the curvature estimation. 

For the estimation of curvature and curliness in 

FiberFind, in the FiberFind section, select 

Estimate Fiber Curvature from the pull-down 

menu and click the Options’ Edit... button.  

 

 

 

 

 

 

 

In the Fiber Curvature Estimation dialog, enter the desired Result File Name 

(.gdr). 

After the fiber curvature calculations are finished, a Result Viewer for the 

FiberCurvature.gdr file opens.  

Under the Results - Report tab, it 

displays the measured Average 

fiber curvature (and its Standard 

deviation) and the Average fiber 

curliness for the given Number of 

Analyzed Fibers.  

Below, a table gives the distribution 

of fiber curvature, listing the Count 

Fraction (%) for the ranges of 

calculated fiber curvatures.  
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Under the Results - Plots subtab, diagrams show the distribution of fiber curvature 

and fiber curliness, corresponding to the count fractions for curvatures and curliness 

of fibers present in the domain. 

In our example, the highest count fractions correspond to fibers with low curvature 

and low curliness. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Besides analyzing the fiber curvature in the structure, FiberFind creates a model of 
the structure by extracting all fibers of the structure and creating fitting analytic fiber 

models if no analytic data was available for the structure before.  
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IDENTIFY FIBERS (AI) 

The final goal of all FiberFind tools is to obtain accurate statistical parameters for 

advanced material design, that can be used e.g., as input data for FiberGeo. 

Since GeoDict 2019, two distinct approaches are followed in FiberFind’s Identify 

Fibers for the identification of individual fibers. The first approach uses classical 

image processing methods, the second one is an Artificial Intelligence (AI) approach. 

See Theory – Approaches for fiber identification for more details. 

1. The identification of fibers with classical image processing methods is optimized 

for low density fibrous materials. FiberFind identifies fibers by creating a skeleton, 

that preserves the topology of the fibers. This skeleton is used to determine the 

center lines of the fibers. 

2. The AI approach uses a neural network that has been trained with great amounts 

of input data. The training data for ground truth is created with FiberGeo. 

Therefore, this approach is capable of identifying individual fibers in a structure, 
as long as the input data for the training was close enough to the fiber properties 

in the real 3D-scan.  

The start of the computation is again a three-dimensional model that has been 

obtained from segmented computer tomography (or FIB/SEM) images of the 

material. Fiber identification provides advanced structure statistics, such as fiber 
length, number of fibers and better local fiber orientation, as well as object-based 

image manipulation (for example, changing the diameter of fibers directly from the 

imported CT-scan images). 

The example shown here, is a part of the imported FIB/SEM image of a carbon paper 

gas diffusion layer (GDL) used for a proton-exchange membrane (PEM) fuel cell. The 

binder has already been removed with BinderFind-AI (see Identify Binder (AI)).  

The input data used, as well as a detailed description of the necessary processing 

steps, can be found in the tutorial Digital analysis of fibers and binder content of four 

carbon paper GDLs, on the GeoDict website. 

 

 

 

 

 

 

 

 

To start, select Analyze → FiberFind from the 

menu bar and, in the FiberFind section, select 

Identify Fibers (AI) from the pull-down menu. 

Click the Options’ Edit... button.  

The Fiber Identification dialog that opens 

contains three tabs: Solver Options, Fiber 

Identification and Output Options.  

 

https://www.geodict.com/Support/tutorials.php
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SOLVER OPTIONS 

Note that this tab is only used, as long as Machine Learning is selected from the 

Identification Method pull-down menu under the Fiber Identification tab.  

If a suitable graphics card is detected during installation of GeoDict, the GPU mode 

is used for running FiberFind-AI, otherwise it is running in CPU mode.  

 

 

 

 

 

 

 

 

 

The version used is displayed on the Solver Options tab. 

 

 

 

 

 

 

 

 

 

 

Second, the choice for Batch Size is related to the memory available on the graphics 
card (GPU). Conceptually, FiberFind loads the graphics card with portions of work 

called batches. Currently, the selection must be made manually, and the parameter 

is set following the value entered in Batch Size.  

The batch size might be chosen too large for what is available on the graphics card. 

In this case, an error message appears. 

 

 

In this case, the number of batches needs to be reduced. Note that for CPU-based 

computation, the choice of batch size is not critical and can be left at the default. 
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For the neural networks, available since GeoDict 2020 SP3 it is recommended to 

reduce the batch size to 1 or 2 (for Fiber Identification: Label straight fibers (4-10 

Voxels diameter).gnn and for Binder Identification: Label binder in round fiber 

structures.gnn). 

FIBER IDENTIFICATION 

First, choose between two Identification Methods: Machine Learning for the AI 

approach, or Analytic to use the classical image processing approach. 

If Analytic is selected as Identification Method, the Fiber Identification dialog 

changes and then contains the single option to Do Shape Analysis. 

Checking Do Shape Analysis allows a more detailed analysis of the fiber shape to 

detect parallel fibers but increases the runtime significantly. If the user does not 

check Do Shape Analysis, the regular analytic fiber identification method is carried 

out. 
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After choosing Machine Learning as the Identification Method, several other 

options are available in the Fiber Identification dialog. However, for most of the 

application cases, the default values can be kept for most of the options. 

Select the neural network best suitable for the structure under consideration under 

Neural Network (.gnn stands for GeoDict neural network).  

 

 

 

 

 

 

 

 

For the second neural network available, Label straight fibers (4-10 Voxels 

diameter).gnn, it is recommended to set the batch size for the computation on the 

tab Solver Options (see page 39) to a small value (1 or 2).  

In the Description, the current constraints for the application of the neural network 

are listed, like the diameter range of the fibers for that the neural network was 

trained. 

The Material to Analyze panel offers the choice of whether FiberFind-AI should be 

applied to all solid and porous materials in the structure or only on a subset, defined 

either by choosing material IDs or materials. 

 

 

 

 

The Threshold is an internal (or expert) parameter that is mostly applied by 
proficient users at Math2Market. It is used for the decision whether a voxel is a 

centerline voxel or not. If the identified fibers are over-segmented, choosing a 

smaller threshold can lead to better results. 

 

 

 

 

Two choices are available as Identification Mode: Use Current Structure and 

Load Neural Network Output. 

 

 

 

The default Use Current Structure should usually not be changed, meaning that 

FiberFind-AI will be applied to the structure that GeoDict currently has in memory. 
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On occasion, the user may want to change the threshold, without having to run the 

identification for each voxel with the neural network again and in that case, the 

option Load Neural Network Output may be very useful. 

 

 

 

Browse to a GeoDict result folder of a previous run of FiberFind-AI and select a 

nnOutput.npz file from that folder. Accordingly, the Material to Analyze and the 

Neural Network to be used cannot be changed, and the loaded structure needs to 

be the same. 

 

 

 

 

 

 

 

 

 

 

The underlying domain can bet set as periodic for the fiber identification by checking 

one or several of the boxes in the Domain-Boundary Options panel. 

However, periodicity is unusual for most 3D scans and this setting is rarely changed. 

 

 

 

 

 

 

 

 

 

Check the Remove Fiber Fragments at Domain Boundary in this panel, to 

remove all fibers that touch the boundary of the domain after the fiber identification 

algorithm. 

Finally, in the lower right of the Fiber Identification dialog, in the Fiber-Shape 

Analysis panel, select the type of fibers in the structure. Curved Circular Fiber or 

Short Circular Fiber are available.  
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Selecting Curved Circular Fiber, FiberFind performs the identification under the 

assumption that the structure might contain curved fibers.  

If Short Circular Fiber is chosen, fibers are identified twice: once with the default 
option of curved fibers and once under the assumption of straight fibers only. For 

the computation of fiber length distribution and fiber orientation, the result of the 

curved fiber identification is always used. 

OUTPUT OPTIONS 

On the output options tab, check Save Fiber-Orientation Distribution as *.gof, 
if the information about fiber orientation should be saved for later visualization, see 

page 57.  

The .gof file contains a volume field with an orientation tensor for each voxel. This 

option is available only, for the Fiber Identification Mode MachineLearning, see 

page 40.  

For the Fiber Identification Mode Analytic, a .gof file is always saved in the result 

folder. 
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FIBER IDENTIFICATION RESULTS 

After running the fiber identification, a folder with the same name as the GeoDict 

result file is saved in the chosen project folder (File → Choose Project Folder... in 

the menu bar). This folder contains folders and files needed internally for the 
calculations. The content of the folder depends on the selected Identification 

Method and parameters. The original structure model on which the identification 

was done is also saved in the folder. 

The GeoDict Result Viewer opens for the result file and statistical properties of the 

identified fibers are shown.  

In the Result Viewer, under the Results - Plots subtab, the user finds histogram 

plots of the fiber length distribution and, for Identification Method Machine 

Learning, the fiber diameter distribution. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

On the left panel of the Plots 

subtab, the number of bins for 

all distributions shown in the 
plots can be selected. Click 

Apply to generate the plots 

for a different number of bins. 

Other options that can be 

selected in the post-
processing panel on the left, 

are explained below, see page 

47. 
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Also present are plots of the Fiber Curvature Distribution and the Fiber Curliness 

Distribution, as well as three plots showing the fiber orientation as histograms of 

projections of the fibers to two-dimensional planes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

To compute the three orientation histograms, each fiber is projected to the two-

dimensional plane. The angle of each fiber segment, weighted with the length of the 

segment, gives an entry in one bin of the histogram, i.e., in one segment of the 

circle.  
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The number of fiber segments for an orientation in the plane is given by the size of 

a segment of the circle. Since the histograms are normalized, this number is always 

a value between 0 and 1. The histogram is symmetric since fiber orientations of 0° 

and 180° are undistinguishable. 

Fibers in this example are oriented mainly in the X/Y plane, a bit more in Y-direction 

than in X-direction. Histograms of X/Z plane and Y/Z plane show large segments for 
0° and 180°, and segments in Y-direction are even a bit larger. In contrast, the plot 

of X/Y plane shows a more homogeneous distribution of fibers in this plane, but the 

preference for Y-direction is also visible there. 
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Besides the bin length for each of the histograms shown, that can be selected by the 

user, additional post-processing options are now available in GeoDict 2022. 

In the histograms of fiber length and diameter, the fibers can be classified with 

respect to a lot of fiber properties. 

 

 

 

 

 

 

 

 

Select a Fiber Property for the classification and define the number of different 

classes by choosing the Number of Fiber Types. In the example shown, fibers are 

separated into two classes according to their diameter.  

Select a Thresholding Method for the differentiation of fibers of different type (k-
Means, Otsu’s method or define a Manual threshold) and the Number of Bins 

used for the separation of fibers. 

Here, 100 bins are used to separate the fibers according to the k-Means method. 

Click Apply to change the Fiber Length Distribution histogram and, if available, 

the Fiber Diameter Distribution histogram. An additional tab (here Threshold by 

Diameter), containing the fiber diameter distribution with the number of bins 
defined for the thresholding, the resulting threshold for the method selected, and a 

Gaussian fit for both fiber types, is created. 
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On the Fiber Length Distribution histogram and the Fiber Diameter 

Distribution histogram tabs, the histograms are shown now as stacked values for 

both fiber types.  

 

 

 

 

 

 

 

 

 

 

 

 

 

The classification of fibers is also included in the Results Report, see page 50. 

The structure with the separated fiber types, can be loaded to the Visualization Area 

under the Fiber Identification Visualization tab, see page 52. 

 

To create an additional tab, showing the layered values in z-

direction for a fiber property, select a Layered Fiber Property 
from the pull-down menu. With Layered Fiber Property 

Weighting define if the mean in each layer is computed with 

respect to the 

number, the volume 

or the length of the 

fibers. 

Click Apply. 

 

A new tab for the layered distribution is added to the Plots subtab, according to the 

values selected.  

For the example shown here, the tab Layered Fiber Curliness Distribution is 
created, showing the mean fiber curliness (weighted with respect to the fiber 

volume) for each layer in z-direction of the structure. 
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Note that the visualization of layered fiber properties in z-direction is only possible 

for Identification Method Machine Learning. 

Click on Plot Options and select one of the histograms available, to access directly 

the dialog boxes for changing the Axis Settings or Graph Styles. These dialogs can 

be accessed as well by a right mouse-click in the histogram. 

 

 

 

 

 

 

 

 

 

 

For more details on modifying plot settings, see the Result Viewer handbook of this 

User Guide.  

 

https://www.geodict.com/Support/UserGuide.php?lang=en
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The information about fiber orientation, fiber length distribution, fiber diameter 

distribution, fiber curvature distribution and fiber curliness distribution is also 

available in tables under the Results - Report subtab.  

In this report, first the total number of identified fibers is shown, here 1397.  

Next, a table shows the number of fibers, the mean diameter, mean length, mean 

curvature, and mean curliness and the orientation for each fiber type, defined via 

the Threshold by Fiber Property, see page 47.  

 

The fiber type specific information is followed by the values for all fibers. First, the 

orientation of all fibers is reported. 
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Since most of the fibers in the example are oriented in X/Y plane, the diagonal entries 

of the orientation tensor for X-direction (0.4132) and Y-direction (0.5404) are larger 

than for Z-direction (0.0464). The value for Y is higher than the one for X, showing 

again the dominance of Y- over X-direction. 

The anisotropy values, together with the Euler angles, are another representation of 

the orientation tensor. 

Both representations of the orientation tensor can be used directly in FiberGeo to 

create a structure with the same properties than the structure analyzed (see 

Reproducing fibrous media using FiberFind and FiberGeo). 

 

Next, in the Report, for fiber length and fiber diameter, the mean value and the 
standard deviation and for fiber curvature and fiber curliness, the mean value are 

shown, followed by tables with the histogram values of the Plots subtabs. 
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On the Fiber Identification Visualization tab, several possibilities of visualizing 

the results are listed. If Identification Method was set to Analytic (see page 40) 

only the .gad file with the curved fiber fit and the segmented analytic fibers is 

available for visualization.  

To visualize the fibers identified by the algorithm, click Load *.g32 in the GeoDict 

Result Viewer under the Fiber Identification Visualization tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Set the structure to invisible, to see only the identified fibers, by clicking Yes in the 

opening dialog. 
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The identified fibers are shown in a variety of colors.  

 

 

 

 

 

 

 

 

 

In the same way, the curved fiber fit (and the straight fiber fit if Short Circular 
Fiber was selected in the Fiber-Shape Analysis panel of the FiberFind options) can 

be loaded by clicking on their Load *.gad buttons under the Fiber Identification 

Visualization tab. In the loaded .gad files, fibers are contained as analytical objects, 

with information about fiber diameter, etc. After the identification of fibers, the 

analytic information contained in the .gad files can be used for modifications of the 

structure model or further calculations that require fiber analytic data. 
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Clicking the (Load labeled structure) Load *.gdt button under the Fiber 

Identification Visualization tab, loads the fibers together with the identified 

centerlines. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Visualize the loaded labeled structure with the centerlines in 2D (View → 2D Cross 

section in the menu bar). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If the centerlines are fragmented, the user might want to re-run FiberFind with a 

lower threshold. If the centerlines appear too thick, a higher threshold value might 

be beneficial. In order to visualize how the threshold affects the result interactively, 

perform the following steps. 

Click the (Load Confidence Field) Load *.npz button to load the unsegmented data 

of the fiber identification. 
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Set the structure to invisible, by unchecking the Structure tab in the Visualization 

panel, above the Visualization area of the GUI.  
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Show the result only for the fibers, by deselecting the material with ID 0 in the 

Visibility pull-down menu of the Volume Field tab. 

 

Select a threshold value between 0 and 1 (here 0.5). Then, select >= as Clip Mode 

to see the voxels that are identified for separate fibers if this value were to be set as 

Threshold for the fiber identification (see page 41).  

 

 

 

 

The goal is to find a threshold 

which does not result in 

fragmented centerlines but also 
does not fuse the centerlines of 

neighboring fibers. 
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Select the (Load Fiber-Orientation Distribution) Load *.gof button to load 

information about the fiber orientation.  

 

 

 

 

 

 

 

 

 

 

Select e.g. Orientation:AngleToZ to get a visualization of the angle with respect to 

the z-axis for each identified fiber segment.  

This option is available only, if Save Fiber-Orientation Distribution as .gof was 

selected on the Output Options tab, see page 43. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Again, set the structure to invisible, by unchecking the Structure tab in the 

Visualization panel, above the Visualization area of the GUI. Show the result only for 
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the fibers, by deselecting the material with ID 0 in the Visibility pull-down menu of 

the Volume Field tab. 

Since in the example shown here, fibers are oriented mainly in x- and y-direction, 

the angle to the z-axis is high for most of the segments. 

 

 

 

 

 

 

 

 

 

 

 

 

Load the structure with fibers of different type assigned to different material IDs in 

.gdt format or with analytic data in .gad format, by clicking Load *.gdt for Load 

property segmented fibers and Load *.gad for Load property segmented analytic 

fibers respectively.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fibers with different material IDs, according to the number of different fiber types 

selected under the Results tab (see page 47), are shown in the Visualization Area. 
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Select Export → Excel (specific) at the bottom of the Result Viewer, to export the 

identified fiber properties to a Microsoft Excel file. A python script is executed that 

creates the file FiberInformation.xlsx and opens this file if Microsoft Excel is 

installed on the computer.  
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The file created contains for each fiber, the identified diameter, length, direction 

vector and the fiber center of gravity. 

For the file created for the example above, the information for the first 8 fibers is 

shown in the following figure. 
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IDENTIFY BINDER (AI) 

The separation between solid and pores of a structure, can usually be done using 

image processing methods during the import of the scanned data sets (see the 

ImportGeo-Vol handbook of this User Guide for more details). However, the 

separation of binder from fibers is often not possible, since they have the same gray 

values in the scan. 

The structure shown here is a segment of a sample of a carbon paper gas diffusion 

layer (GDL) used for a proton-exchange membrane (PEM) in a fuel cell. The fibers 

and binder contained in it are undistinguishable by their gray value in the FIB/SEM 

image.  

Slices of the structure in X and Z-direction, imported into GeoDict, are shown here.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Details on how to import the image and to separate between pores and solid 

material, can be found in the tutorial Digital analysis of fibers and binder content of 

four carbon paper GDLs, on the GeoDict website. 

 

To start, select Analyze → FiberFind from the 

menu bar and, in the FiberFind section, select 

Identify Binder (AI) from the pull-down menu. 

Click the Options’ Edit... button. 

The Binder Identification dialog that opens 
includes the Solver Options and the Binder 

Identification tabs. The Solver Options tab is 

similar to the Solver Options tab for FiberFind-AI, 

explained in pages 39ff. 

https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/UserGuide.php?lang=en
https://www.geodict.com/Support/tutorials.php
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On the Binder Identification tab, select the neural network available under Neural 

Network. In future versions of GeoDict, more than one neural network (.gnn stands 

for GeoDict neural network parameter file) will be provided, making it possible to 

select the best suitable one for the structure under consideration.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Description, the current constraints for the application of the neural network 

are listed, like the fiber cross-section or diameter for that the neural network was 

trained. 

The Material to Analyze panel offers the choice of whether BinderFind-AI should 
be applied to all solid and porous materials in the structure or only on a subset, 

defined either by choosing material IDs or materials. 

 

 

 

The Threshold is an internal (or expert) parameter that is mostly applied by 

proficient users at Math2Market. The neural network provides probabilities that a 

solid voxel is binder or not. The Threshold defines the limit for labelling a voxel as 

binder. 
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In the lower left of the Fiber Identification dialog, the Binder Material specifies 

the material to label the binder. The material chosen should be different from the 

material of any solid or pore material present in the original structure. The ID for the 

binder material is the first ID that is not present in the structure loaded. 

Two choices are available as Identification Mode: Use Current Structure and 

Load Neural Network Output. 

 

 

 

The default Use Current Structure applies the binder identification to the structure 

currently available in GeoDict memory and is used for most of the cases. If the 
evaluation of the output of the neural network should be run again, with a different 

threshold and without having to re-run the neural network inference step, Load 

Neural Network Output may be chosen. 

 

 

 

 

Browse to a .npz file from the result folder of a previous run of BinderFind-AI. Since 

already the output of the neural network is used in that case, no selection of Neural 

Network or Material to Analyze is possible and the loaded structure needs to be 

the same. 

 

 

 

 

 

 

 

 

 

 

Select one or several boxes on the Domain-Boundary Options panel if the 

underlying structure for the binder identification is periodic in one or several 

directions. However, periodicity is unusual for most 3-D scans and this setting is 

rarely changed. 
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After the successful binder identification, the GeoDict Result Viewer opens for the 

result file (.gdr). Under the Results - Report tab, the percentage of solid voxels 

identified as binder is shown.  

 

 

 

 

 

 

 

 

 

 

 

Load the structure with identified binder, by clicking Load *.gdt under the Binder 

Visualization tab.  

 

 

 

 

 

 

 

 

 

 

The same slice of the structure as shown above in 2D (page 61), can be seen here, 

now with binder separated from the fibers. 
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In the 3D visualization, the distribution of binder between the fibers is visible for the 

whole domain. 

 

 

 

 

 

 

 

 

 

 

 

Load the confidence field, by selecting Load *.npz under the Binder Visualization 

tab, i.e., the unsegmented data of the binder identification.  

Keep only the values larger than the threshold 0.5 (selected for the identification) 

by choosing a threshold value of 0.5 and the Clip Mode >=, to see the binder (in 

green to red) identified from the solid voxels (shown in transparent gray) in the left 

figure. This can be compared e.g., with the result for a threshold of 0.8, where less 

voxels are identified as binder (in orange and red), see figure on the right. 
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TESTING THAT INSTALLATION OF BINDERFIND-AI WORKS 

PROPERLY 

With the subfolder FiberFindSetupUserGuide, that is available in the folder 
FiberFind of the GeoDict installation folder, we provide a short example to test that 

the installation of BinderFind works properly, how the results of BinderFind can be 

validated, and to illustrate the essence of the method by testing the algorithm. It 

only takes around 5 minutes to run. 

The example can be run directly from this folder if you have writing access there. 

However, we recommend creating a copy of the folder first, and use this copy to run 

the example. 

TEST THE INSTALLATION 

The procedure to test the installation is as follows: 

1. Start GeoDict 2022 

2. Change the project folder to the folder FiberFindSetupUserGuide: 

Select File → Choose Project Folder → Select Project Folder in the menu 

bar and navigate to the folder FiberFindSetupUserGuide. 

 

 

3. Select File → Open structure (*.gdt, *.gad)… in the menu bar 

4. Select fiberFindInstallationTest.gdt in the folder FiberFindSetupUserGuide 
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If the structure appears in 2D, press Ctrl-3 on the keyboard or select View → 

3D Rendering in the menu bar. The structure displayed in the Visualization area 

shows binder at the point where two fibers join, but fibers and binder are 

undistinguishable by their material ID. It should look like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5. Select Analyze → FiberFind 

6. Select Identify Binder (AI) from the pull-down menu in the FiberFind section 

on the left side of the GeoDict GUI 

7. Click the Options’ Edit … button, to open the Binder Identification dialog. 

8. Click on the Load Settings from File icon at the bottom left. 
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9. Select the file FiberFindInstallationTest.gps and click Open 

 

 

 

 

 

 

 

 

 

 

Since in this case, the .gps file contains the default options, you can also load 

the build-in default settings. 

 

 

10. Click OK to close the Binder Identification dialog and then, click Run on the 

left side of the GeoDict GUI. 
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If an error message appears, the default settings to use the graphics card need 

to be changed, to make the example run on your machine. Follow Step 11 to 

Step 16 below. 

Otherwise, continue with the results shown from Step 17 on.  

 

11. In case an error message similar to the following appears, your graphics card 
might not have enough memory to run the binder identification with the default 

settings: 

 

 

 

 

 

 

Look for the OOM in the second line. It indicates that the graphics card is Out 

Of Memory (OOM) and the settings need to be changed. 

Conceptually, FiberFind loads the graphics card with chunks of work called 

batches.  

Currently, the user has to make the selection of batch size manually, and the 

parameter is set when calling FiberFind. 

12. Click again the Options’ Edit … button (as in Step 5 above)  

13. Switch to the Solver Options tab of the Binder Identification dialog. 

14. Enter 1 as the Batch Size instead of the default value of 2. 

 

 

 

 

 

 

 

 

 

 

15. Set current settings as start-up settings using the icon on the bottom left. 

It is very probable that you need smaller batch sizes also for your other FiberFind 

and BinderFind uses. GeoDict will then use this value by default. Close the dialog 

by clicking OK. 

16. Click the Run button on the left side of the GeoDict GUI (same as in Step 10).  
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17. After the computation, the GeoDict Result Viewer opens and shows the results of 

the computation. 

a. GeoDict reports that 0.24 % of the volume is occupied by binder 

b. GeoDict displays the labeled binder as follows, after clicking Load *.gdt on 

the tab Binder Visualization: 

 

 

Save the structure as fiberFindInstallationTestResult.gdt in the project folder. 
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MEASURE THE QUALITY OF THE ALGORITHM 

The fibers and binder seen in fiberFindInstallationTest.gdt in Step 4 above were 

generated in GeoDict, making it now possible to check how well the algorithm 

recovers the original data. The generation process was as follows: 

First, GadGeo was used to generate two fibers that are oriented almost perfectly in 

the x-y plane. The generated fibers are saved in the fibers.gad file inside the 

InputAndComparisonDataM2M folder. 

Next, binder was added by morphological operations with Model → ProcessGeo → 

Add Binder. The resulting structure can be found in the file fibersAndBinder.gdt 

in the InputAndComparisonDataM2M folder. To facilitate the comparison with the 
output of the algorithm, the fibers in this file have been recolored and the resulting 

structure is saved in the file fibersAndBinderRecolored.gdt in the same folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Finally, the result of BinderFind binder identification is compared with this structure 

by adding the structure fibersAndBinderRecolored.gdt with LayerGeo to the 

result structure fiberFindInstallationTestResult.gdt, i.e., the result of the 

installation test shown in Step 17 above.  

The result structure fiberFindInstallationTestResult.gdt needs to be loaded in 

GeoDict. 
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Then, select Model → LayerGeo in the menu bar and choose Add in the LayerGeo 

section of the GeoDict main GUI.  

Click Edit and browse to the folder InputAndComparisonDataM2M. Select the 

Voxel Geometry as Geometry Mode. Then select MaterialID as the Material Mode 

for the addition and the file 

fibersAndBinderRecolored.gdt.  

Click OK and then click Add in the LayerGeo 

section of the GeoDict main GUI. 

 

Then, in the resulting structure (which is 
available also as 

fibersAndBinderComparison.gdt in the 

folder InputAndComparisonDataM2M), 

Material ID numbers are changed through 
Model → ProcessGeo → Reassign (from the 

pull-down menu) to facilitate comparison with 

the original structure created in GeoDict. 

Reassign Material ID 5 to Material ID 1 and 

Material ID 10 to Material ID 2. Now, the 
original colors (red, green) match at the voxels where both original data and 

analyzed data agree. 

 

All voxels with IDs 1 and 6 were fiber voxels in the original structure, voxels with 

IDs 2 and 9 were binder voxels in the original structure. Reassign a solid material 

to both ID 06 and ID 09 with the information Identified as binder and 

Identified as fibers. 
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As it is shown in the Visualization panel, above the Visualization area, 18 original 

fiber voxels (ID 06) were labeled as binder by the algorithm. By extending this pull-

down menu, we also find that 16 original binder voxels (ID 09) were classified as 

fibers. All other voxels were labeled correctly: 5583 fiber voxels (red, ID 01) and 

276 binder voxels (green, ID 02).  

Formally, the volume fractions can be evaluated after selecting Analyze → MatDict 

Material Statistics→ Structure Information in the menu bar. The results are 

shown below. 

 

On the left, observe the data for the original structure with only two solid materials 
(fibersAndBinder.gdt). On the right, the data for the comparison with the result of 

the binder identification shows four materials. 

The volume fractions for Pore and Manual agree exactly because BinderFind will not 

change a pore to a solid or vice-versa. 

MaterialID 1 and MaterialID 2 are assigned to fibers and binder in both cases. 
MaterialID 6 indicates fiber voxels mistakenly labeled as binder voxels and 

MaterialID 9 indicates binder voxels mistakenly labeled as fiber voxels.  

In summary, we see that: 

1. BinderFind-AI recognizes 99.7% of the fiber voxels as fiber voxels correctly and 

recognizes about 94.5% (0.002208/(0.002208+0.000128)) of the binder voxels 

correctly as binder. 

2. BinderFind-AI almost never classifies a fiber voxel falsely as a binder voxel, but 

classifies the remaining 5.5% (0.000128/(0.002208+0.000128)) of the binder 

voxels incorrectly as fibers. 
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